Sidewinder v6.06 - New Features & Updates

Sidewinder v6.06

Pocket Belt Conveyors
The pocket belt details are now shown in the output reports. An error was also corrected when and adding the cleat mass to the total belt mass.

Report Output - Take-up Details
Improved the report outputting and labels for automatic and winch take-ups.

Easy Profile - Pocket Belt Conveyors
If you change the "conveyor type" to a "pocket belt conveyor" the easy profile windows will now automatically add bend pulleys on the carry and return sides of the belt for any element changes of more than a few degrees. This should make inputting these types of conveyors quicker and easier. The user may still manually tweak the vertical profile elements as need, but this provides an excellent starting point. If a vertical radius is input a convex curve will be added (in place of the bend pulley) as shown below.

Advanced Conveyor Technologies, Inc.
19415 594th Ave Mankato MN 56001 U.S.A
Phone: 507-345-5748 e-mail: info@actek.com
Sidewinder v6.0

General Improvements
Various improvements have been made to the user interface, tooltips, output report, and CAD exporting in v6.0.

CEMA 7th
Corrected the CEMA 7th edition equations for types 1-3 rubbers based on the 2015 errata corrections (pages 165-171).

Conveyor Type
The type of conveyor can now be selected. Selecting the conveyor type will then add/remove various inputs and outputs. Default calculation values such as belt speed, belt width, required pulley diameters, etc. will then be calculated based on the conveyor type. The output reports will also reflect the conveyor type input. Available conveyor types are:

Troughed Conveyors - General conventional troughed conveyor utilizing a 2-6 roll carry side idler frame.

Pocket Conveyors - A new calculation method for pocket belt conveyors. When this option is selected an additional "Sidewall" tab will be shown on the belting input. Sidewall and cleat data can be entered (or selected from the built in library).

Pipe Conveyors - This option is for pipe conveyor design. If this option is selected a 6 roll idlers set will be selected on the carry and return side. Transition lengths, and other details will reflect pipe conveyor design criteria rather than troughed belt criteria.

Feeder Belts - This option automatically adds the pullout forces to the fully loaded case (i.e. "1" is entered in the "Load Pt. Pullout Force" column in the Load Conditions" input table). The user should still choose the desired calculation method on the "Load Point" input page (Arnold, Bruff, Roberts, CEMA, etc).
**Pocket Belt Conveyors**

Pocket belt conveyors have been added to the software. Additionally a range of built in Sidewall belting and cleats (T, C, and TC) have been added. The user can quickly and easily select the required size to meet their specific need.

The output window now shows both a front view, and also a side view with the maximum material slope on the conveyor. Useful output data such as the percent loading, maximum tonnage, and cross sectional area for both the flat and sloped profiles is calculated.

Conveyor layouts are also shown, and of course everything can be exported to CAD with ease!
Required pulley diameters for driving and inflection pulleys are calculated and graphically shown with the sidewall belting.

<table>
<thead>
<tr>
<th>Name</th>
<th>Pulley Type</th>
<th>Design Tension T1 (kN)</th>
<th>Design Tension T2 (kN)</th>
<th>Required Diameter (mm)</th>
<th>Shaft Dia (mm)</th>
<th>Bearing Dia (mm)</th>
<th>Min SF</th>
<th>Hub Def (min)</th>
<th>Bearing L10 (kN/hr)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulley 1</td>
<td>3</td>
<td>22.7</td>
<td>20.5</td>
<td>74 / 41</td>
<td>110</td>
<td>90</td>
<td>9.33</td>
<td>1.64</td>
<td>500</td>
</tr>
<tr>
<td>Motor 1</td>
<td>1</td>
<td>46.9</td>
<td>32.0</td>
<td>106 / 81</td>
<td>110</td>
<td>90</td>
<td>1.74</td>
<td>4.95</td>
<td>500</td>
</tr>
<tr>
<td>Pulley 3</td>
<td>3</td>
<td>36.3</td>
<td>36.7</td>
<td>102 / 61</td>
<td>110</td>
<td>90</td>
<td>2.63</td>
<td>5.87</td>
<td>500</td>
</tr>
<tr>
<td>Pulley 4</td>
<td>2</td>
<td>29.2</td>
<td>19.6</td>
<td>71 / 36</td>
<td>100</td>
<td>80</td>
<td>9.85</td>
<td>2.96</td>
<td>500</td>
</tr>
<tr>
<td>Take-up Pulley</td>
<td>2</td>
<td>19.8</td>
<td>21.2</td>
<td>98 / 55</td>
<td>100</td>
<td>80</td>
<td>2.80</td>
<td>7.24</td>
<td>500</td>
</tr>
</tbody>
</table>

As with conventional troughed conveyors many inputs can be left blank and Sidewinder will intelligently select standard components as required. Output reports include all additional pocket belt information and calculations.
Plan View Layout
A plan view layout is now shown in the report output window. The plan view includes the motors (right angle or parallel), brakes (low/high speed), backstops, flywheels, couplings, pulleys, and more. The plan view is output in the report and can be exported to CAD (with all proper dimensioning). This view can be very useful for the engineer to confirm that input data and items are located correctly as well as performing preliminary layouts and designs.

AutoCAD view of plan view layout.
Brake Details
New information has been added to the brake input page. The user can now select from various built in brakes and standard brake disk sizes.

When a specific brake caliper is selected, the clamping force, maximum clamping force, loss of force per mm, and other details are automatically filled in. The output data not only contains the brake caliper details, but also the maximum and minimum (worn) braking torque. These torques can then been added as additional load cases. This will ensure the brake is sufficiently sized to stop the conveyor even under worn braking conditions, but also check that it is not oversized such that it compromises the maximum belt tensions, pulley shaft limits, belt lift off in vertical curves, and other design criteria.
Horizontal Take-up
The detailed "Take-up" output window has been greatly improved and now shows the full cable reeving ratio, all required sheaves, the take-up trolley, required lengths, and much more. This image is automatically included in the reports and CAD exporting.
Sidewinder v5.65

Load Point (Feeder) Calculations - Report Output
Report details for loading points and feeder calculations are now available.

Top/Bottom Belt Cover Thickness
Users can quick select the belt cover thickness by right clicking to show an input window with standard sizes (especially handy for imperial units).

Turnover Labels
Added labels to the head/tail turnover locations for report outputs.
**User Languages - Russian**
The Russian language has been added to the available language files.

**AutoCAD Exporting**
A few more improvements to the exporting function. This is now essentially completed and we hope you find it very useful. However, as always, let us know any comment and/or suggestions you may have!
Sidewinder v5.62

**Feeder Belt Calculations**
Updated the feeder belt calculations to include several new options, calculation methods, and outputs. An example based on Roberts original BELTCON 2 paper is included and can be found in the /Sidewinder/Examples directory. The paper compares several different methods for a typical belt feeder and is a good start for users wanting to understand some of the basic theories behind feeder belt designs. It can be downloaded from:

http://www.saimh.co.za/beltcon/beltcon2/paper27.html

**Pipe Conveyor Frame Layouts**
Frame layouts for pipe conveyors are now calculated and shown on the general output page.

**Demo Examples**
Updated several of the demo example files.

**Opening old files**
Corrected a bug when opening old version 4.25 and below files.
Sidewinder v5.60

Output Tabs Changes
The "Case" tab has been more appropriately renamed "Summary". The "Project" output tab has been moved to the "All - Summary" tab as shown below. A few other tabs have been renamed and/or moved around to make the layout more streamlined and easier to read.

Project - Equipment Page
The total belt lengths for multiple conveyors is now correctly summed up on the project equipment page.

Sidewinder v5.59

CAD Exporting
Even more improvements to the AutoCAD exporting features. A complete take-up drawing is now output (and properly dimensioned) showing the layout, cable reeving ratios, required lengths, and all other major design aspects. The trajectory and transition CAD outputs have also been improved.
**Belt Transitions**
The belt transitions methods have all be updated (CEMA, ISO, DIN, and Beckley). The output formatting has been standardized between each method so the engineer can quickly and easily compare methods. The auto selection of the required length has also been improved. The default method is CEMA 7th, however AC-Tek recommends using the Beckley method as it is the most accurate.

**Material Trajectories**
Image now shows the belt transition length and pulley elevation (both of which are used for the trajectory calculations).
**Sidewinder v5.57**

**User library - Regional & Language Windows Settings**
Corrected an issue for international users who use commas in place of periods for decimal places in user library files. This was causing the libraries not to work correctly and values were being read as integers. Everything now works properly regardless of the regional and language setting in Windows.

**Sidewinder v5.56**

**Standard Idlers**
Added a few new standards to the idler manufactures list. These include the Indian IS-8598 spec, DIN 22107, and Transroll.
**Sidewinder v5.55**

**User Library - Idlers**
The User Library now supports idlers and the ability to create and custom idler sets. 1, 2, 3, 4, 5, and 6 roll sets are supported. The user can enter as much, or as little information as they like. Each roll type (center roll, wing rolls, and outside rolls on a 5 and 6 roll set) can be individually specified in the library. Like the belting, pulleys, and material user libraries, the idler library is stored in your My Documents/Sidewinder directory as a CSV (comma separated variable) file that can be edited in sidewinder, or an external editor such as excel. Please see "User Customizable Library Files" information below for more details on working with custom user library files.

3D Grid and Terrain Modeling Improvements
Many improvements have been made to the 3D grid and terrain modeling feature in Sidewinder. Importing data files is now much more robust and the software can now fill in and/or ignore missing data area of the imported grids.
AutoCAD Exporting
The AutoCAD exporting feature just keeps getting better. It now includes individual pages for the horizontal curves, head and tail transitions, and material trajectories.
New Horizontal Curve Layout Features

The horizontal curve layout window has been greatly improved. Like the vertical curve input page the user now has the ability to "Undo" changes (Ctrl-Z). The maximum horizontal radii is now checked and the limits are shown. IP points can also be moved in the same manner as the vertical curve page.

If the "Show Contours" checkbox is selected the contours are shown using the settings from the ground profile page. This makes laying out a horizontally curved conveyor much easier!
Sidewinder v5.53

CAD Exporting Individual Pulleys
When exporting a dxf file to CAD the individual drawings for each pulley "type" are output. In this release we have added a side view of all pulleys using that specific pulley type. The belt wrap angle and resultant force vectors are shown (see red arrows in image below).
**Sidewinder v5.52**

**Stockpile Ratholing**
Added a "Rathole Angle" and a "Rathole Height" for reclaim points in the stockpile calculation window. Ratholes can be used for circular reclaim points as well as liner slots as shown below.

The grid resolution is now part of the first input grid as shown below. Also, the user can enter a diameter for a stockpile input rather than the height. In this case the height is based off the stacking angle. If both a height and diameter are entered the height is used (i.e. the diameter is ignored).

**Sidewinder v5.51**
Various improvements to the report drive layout window. This window is used for both the Microsoft Word reports and AutoCAD exporting.
**Sidewinder v5.50**
Sidewinder v5.50 has many new features!

**Stringer Layout, Sizing and Deflections**
Structural input and output tabs have been added. This allows the user to estimate the required stinger size and show the complete layout for the conveyor. A graphical view is shown in the output window (which can also be exported to AutoCAD with all correct dimensions by right clicking on the window). Stringer deflections for the empty, loaded, and flooded belt conditions are all output on the "Structure" output page.
The "Zoom" option buttons will switch between the following three views: the cross sectional profile only, the cross sectional view and one stringer set, and all three stringer sets.

A range of carry and return idler configurations are available. Please see the tooltip for more details on the possible choices. The following page shows some of the possibilities.
Configuration = 1:1 (Carry side to Return side idler spacing ratio)

Configuration = 1:1.5

Configuration = 1:2

Configuration = 1:2.5

Configuration = 1:3

Configuration = 1:3.5

Configuration = 1:4
Right clicking on the stringer channel allows the selection of standard metric and imperial channel sizes. It is trivial to add additional stringer sections (tubular, rectangular channels, etc). Please just let us know if what standard sizes you would like to see added and we will included them.

The output data includes the deflections of the stringer midpoint for various load cases. Also shown are the loads used to calculate these deflections.
**Improved AutoCAD Exporting**

The new AutoCAD exporting includes the conveyor frame, stringers, head and tail layouts, conveyor profile, and individual plots for pulleys! Equipment specifications, belt tensions, and other relevant data is included in an easy to read table format.

Head and tail windows are selected and sized using the same windows as the report output. Thus users can zoom in/out, and tailor the layout window however you like in the report window and have that same view appear in your AutoCAD file.

We hope users find this very useful. Please give us your comments and suggestions on areas you would like to see added or improved upon!
Conveyor Stringer and Frame Layouts

Pulley & Shaft Data and Drawings

Head & Tail Layouts
Belt Driven Reducers - Dodge Torque Arm II
The ability to easily use belt driven reducer has been added. Furthermore, the entire lineup of the Dodge TA-II units have been included.

To use a belt driven system simply select the manufacture as a "Dodge Torque arm II", or you can enter "Shaft Mount" as the "Configuration" on the reducer input page.

Not only will Sidewinder selected the appropriate reducer unit, it will give the exact catalog reducer ratio. Furthermore, the motor frame size, and required minimum sheave sizes are also
determined. From this the software will select the required V-Belt series (AX, BX, C, D, 3V, 5VX, 8V, etc) as well as the number of V-belts!

If you want a different ratio the user can enter a reducer ratio (like 15, or 25) and then sidewinder will try and get a reducer that matched that size. The user can also pick a specific belt type and other input data to base the selection on.

The maximum shaft bore size is output on the motor outage and highlighted in red if it is too small. A wide range of other data is also output on the motor output page and the word report.

We hope you all enjoy this new feature!!!
300+ Standard Belts have been Added
We have updated and added over 300 standard fabric and steel cord belts from a wide range of manufactures. Simply right click on one of the belting inputs (top cover thickness, manufacture, etc.) and you can then choose a belt type, manufacture and a specific belt from the built in list.

Selecting a belt will set the belt modulus, load support, troughabilit, core thickness and mass, plys, and other information.
**Trougability / Load Support / Pulley Diameter Inputs**

In addition to all the new belting that has been added, the specific data for load support, troughability, and pulley diameters has also been added. There is now a button on the detailed belting tab which lets the user access this data.

If the current belt width is not acceptable (for either troughability or load support) this will be shown on the belting output page and the item highlighted in red.
**User Customizable Library Files**

Users can now set their own library files for pulleys, material, and belting! The library files are stored in the default user directory, however the file location can be changed on the preferences page. **All files are stored as basic text files.** Thus users can edit them in excel or any other external method they choose. This is very handy and you can then cut and paste data for external sources.

If data is entered for any item a new library input button will be shown (see image below). If you click this button you will get a pull down list of all the equipment you have entered.
Below is an example of adding a material to the material library file. The material is then available from the user library list.

Here is an example of adding a Belt to the user library file. The belting is then availed from the user library list.

And finally the pulley input window. Pulleys can be "copied" from a current sidewinder file in the pulley input page, and then "pasted" into the user library! Another very hand feature when making your own libraries.
Project Files
Users can now move project files around. Just right click on a file and select move.

Stockpile Bug
Fixed a bug for user who use a "," for a decimal place on the stockpile page. This fixes the resolution and now all calculations will be correct.

Cover Grade Input
An input for the belt cover grade has been added. A right click menu with common covers is also available. This input dose not affect the calculations and is only for report outputting.
**Easter Egg* :)**

We just wanted to say that we have added an Easter egg into the software. We can't divulge how you find it (or it wouldn't be an Easter egg). But here's a hint: type in "Minesweeper" somewhere, and then go to the motor input page. If you find it let us know (and well done for reading this and finding it).

**Sidewinder v5.40**

A "Cutoff height" has been added to the stockpile calculations such that trapezoidal stockpiles can be calculated.

![Stockpile Calculations](image)

**Sidewinder v5.38**

Exporting the material profile from the "Material" output tab, or conveyor profile window, to a dxf file now includes the idler frame and informational text.

![Material Profile and Export](image)
Sidewinder v5.37
Corrected an issue with the cable reeving ratio being correctly saved when selecting a hanging counterweight (0:0 ratio).

Sidewinder v5.29
Microsoft Word 365 reports are now fully supported.

Sidewinder v5.28
Correct several issues with the new CEMA 7th edition calculations.

Sidewinder v5.27
CEMA transition lengths now reflect the CEMA 7th edition and 1/3 toughing height.

Minor corrections and updates.

Sidewinder v5.26
CEMA 7th Edition methodology has been implemented and include the errors and corrections published on September 11, 2014. When selecting the CEMA 7th edition the user can select any of the six default bottom cover rubber types as published.
The excel output has been expanded to include the pulley details as well as the conveyor profile.

Various improvements to the general report word documents.
Sidewinder v5.19
Added MAV 1061 to locking device list.
Updated Danish translations.
Horizontal take-up systems are now shown "horizontally" in the detailed outputs and reports. Various other additions and improvements to the take-up outputs in both the interface and reports.

Sidewinder v5.18
Various improvements and corrections to the Load On/Off Advanced feature. Corrected a bug with the motor Equipment Tags and Commodity Code report printouts.
Sidewinder v5.17
Various improvements to Sidewinder languages files. This includes a quick toolbar menu pulldown list and the addition of the Danish language. The following languages are now supported: English, Spanish, Portuguese, Italian, French, German, Danish, and Chinese.

Sidewinder v5.16
Updated "Horizontal Work Page" to automatically update the "Material Loading Profile" when changing load cases.

Added horizontal curve geometry and resultant lateral displacements in the output reports.

Added various warning and user input validation checks before running calculations.

Sidewinder v5.14
Corrected a bug with the internal lookup data for the Rexnord 3-Stage parallel reducer inertia.

Pulley deflections and factors of safety are now listed on the Project -> Pulleys data sheets.

The V-Belt Ratio is now shown on the Project -> Summary page.
Sidewinder v5.13

Command Line Prompt
Input files can now be opened using the command line, or via a batch file. For example: "C:\Program File (x86)\Sidewinder\Sidewinder.exe C:\myStuff\test.swi" will launch Sidewinder and open the test.swi file.

Sidewinder v5.12

Detailed Pulley Output Page
The detailed pulley output page has been updated with tab controls for belt tensions, end disk, pulley shell, and locking device information.
**Rossi Reducer Catalog**
Added Rossi Reducer Catalog Selection for right angle and parallel shaft reducers.

**Sidewinder v5.11**

**Pulley End Disk Fatigue Stress and Locking Device Bending Moment**
Added Jone's (ref "Fatigue Failures of Welded Conveyor Drums", Jones, D.R.H.) for calculating fatigue stress in the end disk, stiffness of end disk, bending moment transferred through the locking device and end disk into the pulley shell, and resulting shaft deflection including effects of the end disk stiffness.

**Pulley Shell Fatigue Stress**
Added Sitzwohl method to calculate fatigue stresses in pulley shell
Sidewinder v5.10

Pulley Hub Manufactures
Added additional pulley hub types and manufactures including: B-LOC, Ringfeder, MAV, TAS, BIKON, Ecolo, and more.
Sidewinder v5.08

Multiple Conveyor Project's
Corrected the motor and pulley count on the Multiple Conveyor Project's Equipment page.

Load Point / Pullout Forces
A few corrections and additions to the Load Point and Pullout Force calculations.

Sidewinder v5.07

Multiple Conveyor Project Page
There are a number of improvements and additions to the multiple project summary pages.

- A new toolbar has been added which allows files to be easily saved, opened, added, removed, or replaced.
- The user can double click on the file name (top of each column) to quickly open that particular file.
- A project icon button has been added to the main toolbar (next to the print icon)
- Equipment tags and commodity codes have been added to the output summaries.
- Right clicking on a column brings up a menu to remove or replace the current file.
Output Reports
Various changes and improvements to the word report outputs.

The document map (and thus pdf "bookmarks") have been improved and now reflect each of the user selected "Additional Information" output checkboxes on the Sidewinder print page.
**Pulley Locking Device Selection**
The user can now select from a range of locking devices from various manufacturers. This includes XT type hubs, B-Loc, Ringfeder, and BIKON. This selection is located on the pulley input page.

The pulley details are also now included in the output reports if this option is selected (see image above). Additionally the pulley type output in the details window shows the hub dimensions (required width and outer diameter), hub pressure, and other information.
**Pulley End Disk & CAD dxf File Exporting**
The end disk type (Turbine / L-Bottom / T-bottom) can now be selected on the pulley input page. The user can also right click on a pulley type and then export it to an AutoCAD dxf file.

**Other Items**
- The material depth against the skirt boards can now be entered separately for the running and pullout cases.
- The chute discharge mass has been corrected.
- Fixed a small bug with multiple material types and loading points.

**Operating Tonnage**
The user can now select "Operating Tonnage" as a load case. When this is selected the tonnage multiplier is set to a default value of 0.85 (i.e. 85% of the design tonnage for the current material set). However the user can modify this as needed (either as a percentage or entering a fixed tonnage). This is identical to selecting the fully loaded case and entering a tonnage multiplier, EXCEPT that this tonnage will now be shown in the output report as the "Operating Tonnage".

---

 Sidewinder Conveyor Design Software - Updates January - 2016

43

---

AC:Tek
Advanced Conveyor Technologies
Sidewinder v5.05

Profile Copying Between Files
Users can now copy & paste conveyor profiles between sidewinder files. To do this simply right click on the vertical profile and select "Copy profile to Clipboard". Then go to the file with the profile you want to replace and again simply right click and select "Paste profile from Clipboard". That's all there is to it. All element lengths, lifts, pulleys, loadings, radii, etc are all copied exactly. We hope everyone finds this useful (we already do)!

Excel Exporting - Region and Language Settings
For users using certain non US "Region and Language" Settings in the windows control panel (Finnish for example) there is a known Microsoft operating system bug which was preventing Sidewinder from exporting excel files. We have added a workaround for this. Exporting excel files should now function correctly for all worldwide users, languages, and all versions of Windows and Microsoft Office.

Vertical Profile - Radius Checking
When changing an elements length, height, or slope the vertical radius for that element is now correctly checked to ensure it is still valid. If the maximum physical radius is exceeded Sidewinder will warn the user and automatically update the radii with the maximum value. As the current elements dimensions also effect the next vertical curve (i.e. the next elements radius) that is also checked.

DHC Motors - High Speed Shaft Torque - Starting Case
When using a direct hydraulic coupling motor type (DHC) the "high speed shaft torque output" for the "starting" condition now correctly includes the "Other Efficiency Loss" factor. All other values (belt tensions, demand power, etc) are unchanged as they were all correctly calculated.

Equipment Tags & Commodity Code Output
"Equipment Tags" and "Commodity Codes" have been added to the detailed equipment summary page and excel exporting.
**Sidewinder v5.04**

**Material Loading Profile**
The material loading profile in output report output now correctly includes the last element.

**Pipe Conveyor Idler Spacing**
Improved auto idler selection for pipe conveyors.

**Sidewinder v5.03**

Added separate report output checkbox options for material sets and idler sets.

Corrected some formatting issues when locking files (showing the date and locked revision numbers).
Sidewinder v5.02

Users can now set a custom directory location for their manufacture's catalog files. This allows one network location to be used and updated, and thus shared between users. Please note that catalog pdf files are not included in the software installation and need to be provided by the user.
Sidewinder v5.01

Pulley Shaft Calculations

The following updates have been made to the pulley shaft calculations:

1. Shaft stresses and deflections now include the mass of the low speed coupling as an overhung load.
2. The deflection of a three-step shaft is calculated correctly which includes the correct location of each step and shaft diameter.
3. Bending moment and deflection diagrams are updated to print correct values for non-symmetrical shaft (see below).

3-Step shaft with low speed coupling and overhung load

Bending Moment Diagram for shaft with overhung load and low speed coupling
Additional Transition Methods are Added

The following methods have been added to Sidewinder to calculate required transition method:

CEMA: This method uses CEMA 6th edition to calculate required transition lengths.

ISO 5293: This method uses the ISO 5293:2004 standard to calculate required transition length and resulting stresses in the transition.

DIN 22101: This method uses the DIN 22101:2010-02 standard to calculate required transition length and resulting stresses in the transition.

Beckley: This method uses the paper published by D.E. Beckly [Bulk Solids Handling, Vol 2, No. 4, Dec 1982], to calculate required transition length and resulting stresses. Also, this method gives recommendations for transition geometry (idler wing angles and packing heights) for the transition.

AC-Tek: This method is based on the results of a comprehensive analysis on transition completed by finite element analysis, the results of which will be published in BeltCon 2013. This is the AC-Tek recommended method for analyzing belt transitions.

<table>
<thead>
<tr>
<th>Element #</th>
<th>Location (m)</th>
<th>Tension Running (kN)</th>
<th>Tension Momentary (kN)</th>
<th>Safety Factor Running</th>
<th>Safety Factor Momentary</th>
<th>Min Stress (kN)</th>
<th>Required Length Running (m)</th>
<th>Required Length Buckling (m)</th>
<th>Required Length Momentary (m)</th>
<th>Transition Length (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.0</td>
<td>48.1</td>
<td>48.1</td>
<td>30.62</td>
<td>30.62</td>
<td>6</td>
<td>5.07</td>
<td>13.34</td>
<td>30.62</td>
<td>13.50</td>
</tr>
<tr>
<td>11</td>
<td>1990.0</td>
<td>599.3</td>
<td>603.6</td>
<td>5.84</td>
<td>5.81</td>
<td>66</td>
<td>13.10</td>
<td>7.25</td>
<td>5.81</td>
<td>13.50</td>
</tr>
</tbody>
</table>
Main Output Window
Sidewinder now takes advantage of users with larger window sizes. When resizing (or maximizing) Sidewinder, the main output window will show the material profile, conveyor loading, and take-up information. This is very convenient as the user can specifically see the material load case for the given output condition without having to switch to the "Loading" output tab.

Windows Size & Position
Users can now save the default window size and position by simply click on "Advanced -> Save Windows Size & Position". This will now be the default size and location the next time you start sidewinder.
General
There have been several small bug fixes and general interface/report corrections in the new v5.0 release.

Stockpiles
Added material name input/output. Improved graphing and labels. Added XY constrained bonding box dimensions.

Belt Flap
An additional output has been added to the main output tab to warn of potential belt flap problems. This is shown next to the vertical "curves" output. If mode 1 or 2 belt flap is a problem on the return side then "Check" is shown in red warning of a potential belt flap problem. Furthermore, the return side of the conveyor is shown in "RED" where the belt flap is a problem. The user can then go to the belt flap output tab for more details.
**Excel Exporting Options**

Users have always been able to cut and paste grids and data from Sidewinder to Excel. However, a new option to directly export to excel has been added. Simply click "File -> Excel Export". This output creates a very nice and properly formatted excel output spreadsheet with the "equipment summary", "project summary", and "Element Table" information.

As always, if users would like any additional information added to this spreadsheet just let us know. Now that the functionality is all completed adding additional items is no problem at all!

**Reducers Options & Output**

Several additional reducer manufactures have been added to Sidewinder. These include Rexnord, Siemens, SEW, David Brown, and Hanson. The user can also select the reducer configuration (Right angle or Parallel Shaft mounted). Sidewinder will select the required reducer series and catalog number. Particularly useful is that the user can now see the exact reducer ratio for the selected unit, as well as the catalog power rating vs the required rating (based on input service factor). If desired the user can then enter the exact reducer ratio in the input and rerun the calculations to give the correct conveyor speed based on the actual reducer ration, pulley diameter, and motor output RPM.
**Equipment Tags & Commodity Codes**

A new checkbox for equipment tags and commodity codes has been added to the "Project Information" input box. If the user checks this checkbox then additional inputs will appear for all the major equipment (belting, idlers, pulleys, drives, reducers, brakes, etc). These new inputs allow specific equipment tag numbers and commodity codes to be input. An equipment tag number is UNIQUE to each part, whereas the commodity code is unique to a group of components. For example, a conveyor may have three 200 kW motors on it. All three motors may have the same commodity code (assuming they are all identical), however each may have a unique equipment tag.

Pulley tags are shown on the "vertical profile" input page, however the page width must be expanded for these input to be shown.

Users can output all tags to the report by selecting the "Equipment Tags / Commodity Codes" checkbox before creating the conveyor report.
**Multiple Conveyor Project -> Summary**

A total overall summary of all conveyors has been added to the "Multiple Conveyor Projects" page. This page is meant to summarize all the equipment used on the selected conveyors. For example in the image below two (2) conveyors use a 1800 mm wide ST-3150 N/mm belting and the total required belt length (conveyor 1 + conveyor 2) is 5916 m.

The summary includes belting, motors, pulleys, and brakes. The required "matching" parameters are shown in the list. For example a motor "match" is assumed if the type, nameplate rating, and RPM are the same. For pulleys the diameter, lagging type, face width, shaft & bearing diameters, and bearing centers must match.

The idea is that users can now select several conveyors for a project and quickly get a good estimate of the total equipment requirements.

Again now that this functionality has been added we are looking for user feedback on this page. Certainly there is much more which can be added if user find this useful. Let us know what you think...
Multiple Conveyor Project -> Excel Exporting Options
As with the individual sidewinder files we have also added a very nicely formatted excel output option for the multiple conveyor projects page. This includes the "summary", "Load cases", "Pulleys", and the new "Equipment" output pages.

Structural Inputs
A structural input page has been added. Currently this page contains information regarding the take-up cable diameter and sheave selection. Please see the tooltip help for more information on each of the inputs. The report output contains this information as well as other pertinent information.

We are planning on adding additional structural information on this page requiring stringer selection, as well as basic channel size deflection calculations and selections. Stay tuned....
Sidewinder v4.92

Pulley Shaft Design Criteria - Extra Case Options

This input has been expanded to give the engineer even more control on the shaft design tensions.

As described below in the version v4.91 update, Sidewinder will take the larger tension value of either: All Design Level 1 cases, or this 'extra' case. The starting and stopping dynamics for the extra case are NOT used (even if the users selects 'Yes' to Include dynamics). Only the steady state running tensions are used for this extra case.

The available options are now:

None
Don't use or check any other extra cases. This option just uses the regular Design Level 1 cases.

100% NP
If the '100% NP' is selected, then Sidewinder automatically creates, and runs, an extra hidden case (similar to the structural load case calculations). This extra case uses the fully loaded normal friction condition, but it increases the material loading until 100% motor nameplate power is reached. Additionally, all reducer losses are set to zero (for maximum driving torque and tensions). The tensions for this case are again multiplied by the appropriate 'pulley tension multiplier'.

Str. Case
This option uses the tensions calculated from the Structural Load Case. This is very similar to the 100% NP case, except the user has more control over exactly how the 100% motor nameplate condition is created. Note the Structural tensions do NOT include the 'Structural Tension Multiple', but do include the appropriate shaft design tension multiplier (ie Sidewinder correctly does not add safety factor on top of safety factor). Again this is meant to be very similar to the 100 NP case, but will a bit of added extra control by the user.
**Mtr/Blt/PT**
This option uses the installed Motor Power, Belt Rating, and Pulley Type to determine the belt tension. Tensions are taken as follows:

\[
\text{Tension} = \text{Belt Rating} \times \text{Belt Width} / \text{Nominal Running Belt Safety factor} \times \text{PTMultiplier}
\]

\[
\text{PTMultiplier} = 1 \text{ for high tension pulley, 0.8 for Medium Tension, 0.65 for Low, and 0.50 for snub pulleys.}
\]

The T2 pulley tensions is always equal to the T1 tension, except for drives pulleys where T2 tension is equal to T1 minus 50% of the motor torque. One could argue to use 100% motor torque, but 50% is more conservative as it will result in a higher T2 tension.

Motor torque is set to 150% motor nameplate torque if Mtr/Blt/PT option is selected (otherwise it is set to the T1-T2 value).

**Overhung Load Workpage**
We have improved the overhung load calculation estimation by better estimating the reducer and other items. The users can also now easily 'paste' the new results into the pulley input page by simply right clicking the output results page.

However, engineers must still be engineers (ie don't just blindly click estimate and expect Sidewinder to do all the work for you)! Be sure to optimize your 'Shaft to Swing Base Support Distance' (dimension 'E') and minimize the overhung loading. Also check the reducer size, mass, and dimensions with your manufacture for all final engineering and design.

**2 Stage Reducers**
Added and improved reducer support including Falk 2 & 3 stage right angle reducers.
Sidewinder v4.91

Pulley Shaft Design Criteria
This is the design criteria used for the shaft sizing of all pulleys. Previously, the design criteria was selected by the user choosing an option from a pull down list on the pulley/Shaft input page. This is now GONE. We have moved this to the "Design Criteria" page (a more appropriate location) and the new inputs allow much more flexibly for the user. The inputs are now also much easier to understand. But please take a minute and read the following notes!

Only Design Level 1 cases are used for pulley shaft design calculations (which are based on fatigue loads). Design Level 2 cases are by definition uncommon and would not normally be used for the shaft design. Besides, if you want to use a design level 2 case for your shaft calculations, then just make it a design level 1! Remember, you can set the design level on the 'Load Conditions' page.

However, pulleys and shaft should still always be checked by the manufacture for maximum structural loads and other cases. Pulley manufactures need to verify that under these conditions
the pulley will not fail!

Here is how the new design criteria inputs work:

<table>
<thead>
<tr>
<th>Pulley Shaft Design Criteria</th>
<th>1.10</th>
<th>1.25</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulley Tension Multiplier - HT</td>
<td>Other</td>
<td></td>
</tr>
<tr>
<td>Include Dynamics</td>
<td>Running 100% Power</td>
<td>No</td>
</tr>
</tbody>
</table>

The resulting conveyor tensions (maximum values of running or momentary depending on the user input) are multiplied by the pulley tension multiplier. All High Tension (HT) pulleys are multiplied by the HT multiplier. All other pulleys (medium tension, low tension, and snubs) use the 'Other' pulley tension multiplier input. This is the value that is then used for the pulley shaft fatigue design calculations.

Include Dynamics
If the 'Include Dynamics' input is set to 'Yes' then the starting and stopping tensions are also used for the pulley design. Only Design level 1 starting and stopping tensions are used. The pulley tension multiplier is NOT used on top of the dynamic tensions (i.e. the multiplier is set to 1 for the dynamic tensions).

For example: If the running tension of a high tension pulley is 125, the HT multiplier is set to 1.1, the starting tension is 150, and the 'Include Dynamics' input is set to 'Yes', then Sidewinder will use the larger of either 125 * 1.1 (137.5) or 150. In this case 150 would be used.

Running 100% Power Case
If the 'Running 100% Power' is set to 'Yes', then Sidewinder automatically creates, and runs, an extra hidden case (similar to the structural load case calculations). This extra case uses the fully loaded normal friction condition, but it increases the material loading until 100% motor nameplate power is reached. Additionally, all reducer losses are set to zero (for maximum driving torque and tensions). The tensions for this case are again multiplied by the appropriate 'pulley tension multiplier'.

Sidewinder will take the larger tension value of either all Design Level 1 cases, or this extra '100% motor power' case. The starting and stopping dynamics for the extra 100% motor power case are NOT used (even if the users selects 'Yes' to Include dynamics). Only the steady state running tensions are used for this extra case. This is recommend and by design. Should the user want to design the shaft with 100% nameplate power and include the dynamics, then they would simply need to create an additional load case using an increased tonnage to achieve 100% motor rating.
Like the structural tensions, you can look at the extra "100% motor power" tensions on the Details -> Elements output page as shown below:

**Reports - Pulley output and details**
We have made a number of improvements to the pulley and shaft output tables in the reports.

**Coefficient of Friction**
For all design level 2 cases the allowable coefficient of friction for steady state running is set to the momentary value (design level 2 cases are by definition momentary conditions).

**Multiple Conveyor Projects**
Added a number of new items to the multiple conveyor project pulley output pages.

**Idler Shaft Deflection**
Shaft Deflection information has been added to the detailed idler output page. No changes in any of the calculations, but this will help any users who want to check items using hand calculations. Remember, unlike the idler L10 life calculations, shaft deflection does NOT take into account the "vlm" factors (vibration factor, load cycle factor, and the material lump factor). Only the static loads are included for shaft deflection. These are material mass, belt mass, vertical/horizontal curve forces, idler roll mass, and the installation tolerance. Be aware that the items are corrected for the toughing angle (calculated per roll) and the element slope. Also, be aware that the vertical BEARING load is NOT equal to the roller normal load. The two bearings...
in a roll may (and usually do) have asymmetric loading and the values shown are for the bearing that is most heavily loaded.

Sidewinder conveniently output all these factors and values for the engineer, should you ever want to calculate anything by hand!
Sidewinder v4.90

Return Element Skip Points
Do you ever have a tripper or booster station and end up with a return side that looks like this?

You have correctly used a return element, however the return element also automatically mapped back all the pulley and elements of the tripper station (which you didn't want). Previously, this could be solved by using two return elements, however this case is so frequent that we have added a feature to easily fix this.

You can now enter a specific number of elements to "skip" when the automatic return side element is mapping back the carry side. A value of "5" in our example above correct the issue as shown below. The return side mapped back all the carry elements, but then when it hit the first pulley it "skipped" 5 elements, and continued mapping back the rest of the carry side.

This is even more useful for movable trippers. You can now simply move the tripper location on the carry side, and the return is corrected automatically!

Enjoy...and as always your feedback is welcome and appreciated!
Structural Tensions Output
It seems a bug crept into the structural tension output. This was causing the structural output table to correctly include the structural case for some files. This has been corrected.

Reduced Belt Speed Flag for VSD Control
If you are using a VSD drive, and have specified the motor RPM, reducer ratio, and the pulley diameter (or even if this is blank since it is based on the belt rating), then your belt speed has now been set. However, in Sidewinder you can (and always have been able to) overwrite the input speed since many conveyors run at reduced speeds and tonnages with VFD control. Alternatively the user may have made a load case which has a reduced belt speed.

This is all fine and nothing in the calculations has changed. However, Sidewinder now highlights the belt speed input "green" warning the user that the motor will be running at a speed other than synchronous. Additionally, the belt output shows both the reduced speed and the synchronous speed for easy reference. As discussed in update 4.61 - "Running VFD (VSD) Drives at Reduced Speed", a VFD that is run at reduced speed also has reduced power, and this is also shown in the output.
**Sidewinder v4.89**

**Material Trajectories**
Corrected dxf exporting of material trajectories for English units.

**Report Updates**
Various improvements to the output reports.

---

**Sidewinder v4.88**

**Pulley Shaft Sizing - Imperial Units**
When using imperial units the pulley shaft size selection now defaults to the following standard sizes: 1 3/16, 1 7/16, 1 11/16, 1 15/16, 2 3/16, 2 7/16, 2 11/16, 2 15/16, 3 7/16, 3 15/16, 4 7/16, 4 15/16, 5 7/16, 6+(default to every 1/2")

**Pulley Face Width - Imperial Units**
When using imperial units the pulley face widths now default to the following: 24" belt and below adds 2", 36" belt and below adds 3", 60" belt and below adds 4", otherwise adds 6".

**Take-up Convergence**
Corrected a small take-up convergence issue on certain files when auto calculating the take-up tension.
Sidewinder v4.86

CEMA Idler Inputs
Added "Total Set Drag" and "Forward Tilt" inputs when using the CEMA idler input page. Previously these options were only available when using the "Universal" idler input method.

Idler Output Results
In the element output table the "Idler Force" column has been split into "Idler Drag" and "Idler Other". Idler drag is the drag from the idlers seals only (and the temperature Kt factor). The Idler Other column is the drag from idler misalignment and forward tilt. By splitting these items up it gives the engineer a better understanding of where all the individual element forces come from.
Sidewinder v4.85

Report - Pulley Tensions
If the users selects the "Pulley Details" checkbox on the report page, then there is a new pulley summary table which has been added to the report. This table shows the pulley tensions for each load case and for both running and dynamic conditions.

![Pulley Tensions for all Load Cases and Conditions](image)

Structural Tonnage Input
The structural tension case now correctly reflects the tonnage input value when 'tonnage' is selected as the criteria for the structural loadings. If the tonnage value is left blank then Sidewinder will automatically calculate the tonnage required to provide 100% motor nameplate running for the steady state condition.

![Structural Tonnage Input](image)

3D Ground Profile Grid
Reset button now scales the X, Y, and Z axis to the current grid limits.
Sidewinder v4.84

3D Ground Profile Grid
Corrected plotting bug when using negative values for the 3D grid files. Also corrected bug when plotting the contour spacing.
**Sidewinder v4.83**

**Extra Drag Load Cases**
The ability to add up to five custom extra drag cases. Previously, the user could manually specify a unique drag on any element along the conveyor profile. This was done by entering a value in the "Extra Drag" column on the Conveyor Profile page. However, this drag was added to every load case.

The "Extra Drag" feature has not changed, and the "Extra Drag" column is still present. However, the feature has been expanded and the user can now specify a "Extra Drag Case" number (1-5) in the load conditions page. For example, if the user enters a value of 1, then a new "Extra Drag 1" column is shown on the Conveyor Profile page. The calculations for that load case will use the drag values from that column (rather than the original Extra Drag column). This is a very handy and powerful capability, but also very easy to use.

**Stockpile View Bug**
Fixed a small bug when changing views before any stockpile calculations have been run.
Sidewinder v4.82

Idler Manufacture - Preferences
Added idler manufacture to user preferences.

Pullout Forces - CEMA Method
Bug Fix: When using a 90 degree build up angle the material cutoff height input was being taken as the distance from the top of the skidboards to the top of the material. The correct distance is from the beltline to the top of the material. This bug only occurred when using a build up angle greater than 89 degrees (all other angles are correct).

Running Torque Limit
Corrected an issue with the "Running Torque Limit" motor input when using multiple VFD drives.

Stockpile Density
The stockpile input density is now correctly output on all reports.

Sidewinder v4.81

Stockpile Calculations
Various improvements to the stockpile reports. Negative values for the "Base Conveyor Elevation" are also now allowed and saved.

Conveyor Profile - Ground Line Importing
both positive and negative values can be imported for the ground line profile. Useful for underground conveyors as shown below.
**Sidewinder v4.80**

**Pulley Shaft Calculations**
Added the shaft slope at the bearing on the details page and report output (previously only the angular slope at the hub was shown).

**Sidewinder v4.79**

**Pipe Conveyor Stresses**
Fixed automatic idler spacing for pipe belts so that all vertical radii are reduced per input table (not just convex curves).

**3D Terrain modeling**
Updated the 3D surface profile & terrain modeling to correct some rounding error issues when using large coordinate value.

---

**Sidewinder v4.78**

**Belt Mass Multiplier**
Corrected a bug in the new v4.77 belt mass multiplier input (below). This was setting the belt mass multiplier for the high/low friction case to 1 rather than the increased/decreased mass.
Sidewinder v4.77

Design Criteria
A new column for "momentary" (i.e. starting and stopping conditions) has been added to the Design Criteria input table. This adds the following major features:

Momentary Safety Factor - Can now be independently specified for fabric and steel cord belting. The default values are 1.25 (i.e. 125%) for fabric belting, and 1.15 for steel cord.

Pulley Friction Factor - Previously the default value for momentary conditions was 1.2. Thus if the steady state running friction factor for rubber was 0.30, then the momentary factor was 0.30 x 1.2 = 0.36, and if the ceramic input was 0.35, then the momentary allowable value for ceramic lagging was 0.35 x 1.2 = 0.42. The user can now enter separate momentary values for rubber and ceramic lagging. Furthermore, this input can be entered as a multiplier (i.e. 1.2 as previously used), or as an absolute value (i.e. 0.42 or 0.475...whatever you like)!

Defaults values for all new inputs can also be specified in the user preferences input.

Other minor items include:
Local Safety Factor Multiplier (momentary column) - Normally this is left blank in which case the running value is used (1.10). However, the user can now change this if desired.

Minimum Allowable Stress (momentary column) - The minimum allowable stress can now be entered by the user. Neither CEMA or DIN discuss the minimum allowable momentary stress criteria, however as a rule of thumb - 1% of the belt rating can be used (which is the default value if left blank).

User Interface Performance Improvements
We have made some significant improvements to the performance of the user interface. These changes don't have any effect on the programs features or calculations, but result in a smoother, and much faster, user interface!
**Tonnage Calculator**
There is a new button located next to the Tonnage input. This button brings up a simple tonnage calculator window which is very handy when determining the annual conveyor throughput (or back calculating the tonnage requirements based on annual or daily throughput requirements). Nothing magic in the calculations, but this sure beats getting out the calculator and manually doing it (or trying to find that spreadsheet you made up 6 months ago!).

**New Load Case Option - Belt Mass Multiplier**
The "High Friction - Low Belt Mass" load case option has been removed and replaced with the addition of a belt mass multiplier input column. This input allows the user to make up any high/normal/low friction case and then use any belt mass desired for that specific load condition. This value can be greater, or less than 1.0 depending if you want to increase or decrease the mass for the specific load case. If the value is greater than 4, then this input is used as the actual belt mass rather than a multiplier.
**Material Lump Shape Factor**
Added an official input line for the "Lump Shape Multiplier" (previously this was sort of hidden as it was located beside the lump size input). This factor allows the lump to have an asperity to it (i.e. not just be circular). Please see the tool tip for more information on using this input.

**Load Conditions - Organization**
You can now move load cases up or down by just right clicking on the case and going to "Load Case Tools -> Move Load Case Up/Down".
**Sidewinder v4.75**

**Load On/Off Additions**

Loading on/off belt tensions and animations can now be done for the entire conveyor length, or for **any user specified point along the conveyor**. This is very nice if you want to look at the belt tensions at a specific location as the belt loads and unloads.
Belt Flap Plotting
The "All" case summary flap plot now only includes design level 1 cases (design level 2 are consider momentary and thus are no longer shown on the "All" case plot).

Transfer Point Material Buildup
The user can now select either the head, or tail, location for the material buildup calculations. If the "receiving belt" option button is selected then the user inputs the belt speed and stopping time of the receiving conveyor and the material buildup at the head chute is calculated. If the "feed conveyor" option button is selected the feeding belt speed and stopping time can be entered and the material buildup at the tail of the conveyor is selected. For the most conservative design the longest stopping time for the feeding belt should be used, or the shortest stopping time of the receiving belt.

Material Lump - Trajectory
If desired the material lump can be shown on the trajectory plots. The lump is placed at the very top of the material cross sectional area and the speed is increased by 5% for a slightly more conservative design value.
**Structural Loads**
The user can now look at the element tensions for the structural tension case. This can be found on the details -> Elements -> Structural tab. Also, the user can enter a brake multiplier for the structural case if desired.
**Coupling Stresses**

Pulley inputs for coupling information have been added as shown below. This is important when using shrink fit low speed couplings. The stresses due to the shrink fit can cause "K" factors of 2-3 and thus the shaft stresses should be checked at this location. This location is now labeled as "Point G" in the detailed shaft output page, and is specified at the center (of one half) of the low speed coupling.

The pulley & shaft weight also no longer includes the total overhung load distance, but correctly uses the shaft length only to the end of the coupling itself.
Sidewinder v4.70

Feeder Belt Calculations
All new and greatly improved! New methods include CEMA, Roberts, Resiner, Bruffs and Johanson. The user can now select & compare different methods. Both the flow condition and initial starting forces are calculated. When a method is selected only the relevant inputs are shown for easy understanding of what parameters are used.

A new feeder belt video tutorial is in the works, but meanwhile users should refer to the paper "Design And Application of Feeders for the Controlled Loading of Bulk Solids onto Conveyor Belts" from Alan Roberts for most of the calculation details.
**Capstan Option**
Added the ability to simulate a capstan (i.e. brake the take-up system) for the operational and emergency stopping cases for conveyors using a gravity take-up system. Capstans are basically a brake placed on the take-up cable between the take-up pulley trolley and the counterweight (they are not applicable on hanging counterweight systems). This fixes the take-up displacement in an emergency top and causes the tension at the take-up to increase.


**Brake Torque Multiplier**
Added a "Brake Torque Multiplier" to load case table. This allows the engineer to simulate new/worn brake torque cases and conditions.
Sidewinder v4.66

AutoCAD Exporting of Material Profile
A bug was fixed when exporting the material cross sectional profile to AutoCAD. When using an aspect ratio other than one (i.e. not a circular lump) the irregular lump shape is now correctly exported to the dxf file for AutoCAD.
Fenner Dunlop Solid Woven Belting

The option to use solid woven belting is now available in Sidewinder. A solid woven belt can be selected by simply setting the number of plies to "0". We realize a solid woven belt technically is a single ply, but this is how we have decided to implement it in Sidewinder. Thus if you select fabric belting, and "0" for number of plies, the belting will be calculated using the Dunlop catalog information below.

The values sets are: belt core thickness; belt core mass, permanent elongation, required pulley diameters, splice step length estimates, and the belt covers are slightly reduced to more closely reflect solid woven belting (although as with fabric belting these are only estimates and the user should always specify the final values).

<table>
<thead>
<tr>
<th>BELT DESIGNATION</th>
<th>WEFT STRENGTH N/mm</th>
<th>BELT THICKNESS* mm</th>
<th>BELT WEIGHT* kg/m²</th>
<th>MINIMUM RECOMMENDED DRUM DIAMETERS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>High tension mm</td>
</tr>
<tr>
<td>2240</td>
<td>400</td>
<td>250</td>
<td>5.5</td>
<td>7.3</td>
</tr>
<tr>
<td>2800</td>
<td>500</td>
<td>275</td>
<td>7.7</td>
<td>10.1</td>
</tr>
<tr>
<td>3400</td>
<td>580</td>
<td>275</td>
<td>8.0</td>
<td>10.3</td>
</tr>
<tr>
<td>3700</td>
<td>680</td>
<td>300</td>
<td>8.1</td>
<td>10.5</td>
</tr>
<tr>
<td>4800</td>
<td>800</td>
<td>330</td>
<td>8.3</td>
<td>11.0</td>
</tr>
<tr>
<td>5000</td>
<td>875</td>
<td>330</td>
<td>8.5</td>
<td>11.1</td>
</tr>
<tr>
<td>6000</td>
<td>1000</td>
<td>380</td>
<td>8.8</td>
<td>11.2</td>
</tr>
<tr>
<td>6500</td>
<td>1140</td>
<td>390</td>
<td>9.4</td>
<td>11.9</td>
</tr>
<tr>
<td>7000</td>
<td>1250</td>
<td>390</td>
<td>9.5</td>
<td>12.2</td>
</tr>
<tr>
<td>8000</td>
<td>1400</td>
<td>350</td>
<td>10.4</td>
<td>13.2</td>
</tr>
<tr>
<td>10000</td>
<td>1600</td>
<td>375</td>
<td>10.5</td>
<td>13.2</td>
</tr>
<tr>
<td>12000</td>
<td>1850</td>
<td>350</td>
<td>11.9</td>
<td>13.2</td>
</tr>
<tr>
<td>15000</td>
<td>2100</td>
<td>425</td>
<td>13.9</td>
<td>17.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Sidewinder v4.65

CEMA Idlers - Details
Added the full details for the CEMA L10 life calculations of each element. At view this just go to the details page and click the idlers tab. You can then select any element for the detailed calculations.

CEMA Idlers CIL / Load Rating
Added the calculated idler load rating (CIL) to the element output table when using the CEMA idler method. Also corrected the load rating input label which was incorrectly labeled (kg) instead of (N).
Microsoft Word 2010 - 32 & 64 Bit
Improved support for Microsoft Word 2010 (both 32 and 64 bit versions)

Pipe Conveyor Calculations
Various improvements have been made to the pipe conveyor calculations and reports. Also it should be noted that the allowable fill (utility) is now based on the percentage of the maximum lump size to the pipe diameter as follows:

- 0-10% the allowable pipe fill is 75% of the total volume
- 10-20% the allowable pipe fill is 70% of the total volume
- 20-30% the allowable pipe fill is 65% of the total volume
- +30% the allowable pipe fill is 60% of the total volume

For example below we have a 45 mm lump which is 9% of the available inside diameter of the pipe. Thus the allowable filling (utility) is 75%. The actual fill is 73% and there this is 97% utility.

Transfer Chute Volumes – Pipe Conveyor Designs
Correct issue with pipe conveyor designs and the discharge transfer chute material volume output (was always zero).
Sidewinder v4.61

Plumber Block & Bearing Library
Added the entire SKF bearing and SNL housing catalog (over 215 bearings and 115 housings)! Please see the “Pulley Plumber Block & Bearing Inputs” information down below on these new inputs. We have also updated the XT hub selection in the Details -> Pulley output page.

<table>
<thead>
<tr>
<th>Shaft Diameter (mm)</th>
<th>Hub Diameter (mm)</th>
<th>Bearing Diameter (mm)</th>
<th>Bearing Center Distance (mm)</th>
<th>Hub Center Distance (mm)</th>
<th>Estimated Pulley &amp; Shaft Mass (kg)</th>
<th>Bearing Series</th>
<th>Plumber Block</th>
<th>Locking Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>110</td>
<td>90</td>
<td>1575</td>
<td>1225</td>
<td>331</td>
<td>23220</td>
<td>52</td>
<td>XT40</td>
</tr>
<tr>
<td>10</td>
<td>100</td>
<td>80</td>
<td>1560</td>
<td>1225</td>
<td>309</td>
<td>23220</td>
<td>52</td>
<td>XT40</td>
</tr>
</tbody>
</table>

Screen Capture (Ctrl-G)
If you ever want a quick screen capture of sidewinder, just press the “Ctrl-G” key. This copies the screen to the clipboard and you can paste it in an E-mail or word document. You can also access this from “File -> Screen Capture”. Of course you can already right click and select “copy to clipboard” on many sub windows (material cross sectional profile, conveyor profile, etc) but this allows the full sidewinder window to be copied.

Vertical Profile Undo
Corrected a small issue when using Ctrl-Z to undo in the vertical profile. This now all works as it should.
Running VFD (VSD) Drives at Reduced Speed

On many systems you may want to run a VFD at a reduced speed. For example, the load case table below a case has been added for 50% tonnage, and the belt speed reduced to 3.0 m/s.

At this reduced speed, the available VFD power is also reduced. A VFD is a constant torque machine, and thus the power is reduced proportionally with the speed. The nominal speed of this conveyor was 5.0 m/s, and the reduced speed is 3.0 m/s. Thus at 3.0 m/s the available power is $3/5 = 60\%$.

If we run the calculations and look at the output we see the normal case is as we would expect. 6 x 2100 kW drives, thus 12,600 kW installed, and at 9945 kW the percent nameplate is 79.8%.

However, if we now look at the 50% tonnage condition, the output shows a "Reduced Motor Nameplate" (Motor Nameplate is abbreviated MNP) value. The motor rating is 1241 per motor, thus with a demand power of 5705 kW we are at 76.6% nameplate.

This is a simple, but important, aspect to remember when working with VFD drives!
Sidewinder v4.58

Fluid Coupling Starting Torque
When the starting option is set to fluid coupling, then the maximum starting torque will be calculated using the demand power for each specific load case. The starting torque is calculated using the formula:

\[
\text{Starting Torque} = \text{Min Torque} + (\text{Ma} \times \text{Torque} - \text{Min Torque}) \times \text{Percent Demand Power}
\]

For example let say the minimum starting torque is set to 100%, and the maximum starting torque set to 140%. Then if the demand power for the empty belt is 15% of the motor nameplate rating, then the starting torque would be \(100 + (140 - 100) \times 0.15 = 106\%\) for that case. If the fully loaded power was 85% motor nameplate, then the starting torque would be \(100 + (150 - 100) \times 0.85 = 134\%\) for that case.

The idea behind this methodology is that the empty belt starting torque can be reduced from the fully loaded torque to more closely match the real behavior of the couplings. Furthermore, extended delay couplings such as a TVVS can be given a lower starting torque than say a TV coupling would have.

Default minimum starting torque values are 100% for TV couplings, 90% for TVV couplings, and 80% for TVVS couplings. However the user can adjust these values as they see fit.
Sidewinder v4.57

**Belting Inputs**
We have reorganized the belting inputs to provide a little better organization. We have also added a specific “Splice” input page which is especially useful for steel cord belting inputs, and new splice details can be entered. Likewise the splice output table contains more information about the splice itself.

**Belting Manufacture Inputs**
You can now right click on any of the belting input cells (except for belt width, rating, etc. which already have right click library menus) for a quick list of various belting manufactures and specific belting properties. Both fabric and steel cord belting is available. By selecting a specific manufacture (Goodyear’s Pylon Plus belting for example is shown below), many of the specific belting details are automatically filled in (core belt weight, minimum high tension pulley diameter, splice lengths, cable size, etc).

We are still adding belting information, and but we’d like your comments on if you find this feature useful, and/or other belting manufactures info which you would like to see added!
Cross Sectional Conveyor Image

You can get a general feel for your conveyor layout by simple right clicking on the Material output window and selecting “Carry & Return with Frame”. Also, above this selection is the option to “Show the Idler” frame (which has been available for a while but many users are not aware of this).

The entire frame and cross sectional area is one of the areas we would like to expand more on. Stringer selection, deflection, and other basic structural item calculation inputs are being considered for the next Sidewinder release. However, this is another area we would like to get some user feedback on as to what would really be useful for YOU the end user. Drop us an E-mail!
And remember you can always right click and copy/paste images to other applications like Word or excel.

**Loading Points – Various Design Options**
The receiving belt input speed and deceleration tab have been moved from the belting -> other input page, to the dynamic input tab (which is a more appropriate location). These inputs simply affect the material build up in the transfer chute calculations.
Pulley Plumber Block & Bearing Inputs
Added inputs for the pulley plumber blocks, bearings, and bearing dynamic capacity for pulley L10 life calculations and report outputs. We have also improved the output layouts for the pulleys and shafts.
**Loading Points – Various Design Options**

You can now change the loading point input values for different load cases. In other words, let’s say you have one loading point, but you want to analyze two different pullout conditions for that load point in the same file. Previously, you could only choose to either include, or not include, the pullout forces by either entering “1” in the load point column, or leaving it blank.

Now, you can enter 2 or 3, or 4 in the load point pullout force column (shown below), even though you only have one real loading point on the conveyor. Then you can go to the “Load Point” input page and specify different options for loading points #1 and #2 (or #3, #4, etc). Sidewinder will simply use the input values for the desired load point for each load case.

![Load Conditions Table]

**Horizontal Curves**

Horizontal curve sections are now shown in gray (dark/light) on the conveyor profile page and other outputs for easy clarification. Banking angles and side guide rolls spacing can now be automatically set in the conveyor profile by right clicking on the horizontal curve columns.

![Horizontal Curves Diagram]
**Terrain Modeling**

A number of various improvements have been made to terrain modeling input window, and importing 3D terrain files. Please see the two new video tutorials file for more details on these features:

29 - Tutorial - Terrain Modeling - Part 1.avi  
30 - Tutorial - Terrain Modeling - Part 2.avi
**Effective Pulley Diameter**

This output has always been shown, but we often get questions on this and thus have added to several important locations (in both the user output and the reports). The effective pulley diameter for belt speed, braking torque, backstop torque, etc. is calculated using the bare pulley diameter + two times the lagging thickness + 2 times the belt bottom cover. Please note that we add the belt’s bottom cover thickness to the effective pulley diameter. Some could argue that ½ the belt cord thickness (or for steel cord belting ½ the cable diameter) should be added. However, we feel simply adding the bottom cover thickness is adequate (not to mention most users, and software packages completely ignore this issue altogether)!

**Backstops**

Added the AS-1755 criteria to the backstop output. Tooltips are also available for each item for more detailed information.
Language Updates
We have updated the language files for several languages including Spanish, Portuguese, and Chinese. However, if you are using any of these languages (or any of the other languages built into sidewinder) and there are translations that you feel are incorrect, please just let us know as they can easily be corrected!

Also remember you can switch between English and any other language by simply pressing F8 at any time. To set up the preferred alternate language simple go to File -> Preferences and change the language option.
**Sidewinder v4.49**

**Chinese Language**
Sidewinder now supports the complete Chinese language for all inputs, outputs and reports.

Be sure and install the “East Asian Languages” in the windows ‘Control Panel’ -> ‘Regional and Language Options’ to use this feature.
Multiple Conveyor Summary - Now allows data to be listed in rows, or grouped together

Users can now select the option of either combining items such as idlers, motors, pulley types, backstops, and brakes, on a single row, or as multiple lines. The “Show data on multiple lines” checkbox option may be easier in some cases (and when exporting to excel), however, the multiline option is more compact.

For example, 4 individual brakes are shown in column 1 below:

Verses 4 individual brakes combined here. Same concept holds for other “set” data like pulley types and motors.
**Sidewinder v4.46**

**Backstop Safety Factor**
The user can now specify the desired backstop safety factor with respect to the total installed motor power. If left blank, this input will default to the motor starting torque (which is the currently used value).

**Multiple Conveyor Summary Pages**
Various new additions and a couple label corrections to these pages.
**Sidewinder v4.43**

**Structural Loading**
The engineer now has full control of how the structural loads are calculated. We have added a “structural input” tab on the main project input page. This window also allows the user to specify the flooded belt material properties.

Please see tutorial #27 for more information on this topic.

A new output tab has been added to the main output window showing the flooded belt information and the structural tensions. Bearing X & Y reaction forces are also output at each pulley.
Report Output Additions
The above structural and flooded belt information is now output in the report data sheets if the users choose to output the “structural” data. Additionally the pulley details page includes a small graphical image of each pulley and the incoming and exiting belt tension vectors.
**Ability to move IP/Pulleys graphically**

The ability to simply click on pulleys and graphically move them around is now possible in the vertical profile page. To do this simply left click and hold on the incoming or exiting point of the pulley and move your mouse around. Clicking on the incoming point only changes the length of the incoming element (all elements after the pulley are fixed RELATIVE to the pulley). Clicking on the exiting point fixes ALL elements EXCEPT the pulley and its incoming and exiting elements.

Please see tutorial “26 - Using the Mouse to Move IP Points and Pulleys.avi” for more information on this feature.
Motor Inertia Option for Starting Calculations

Under the dynamics tab the user can now select the checkbox whether or not to “Include Motor Inertia” in the starting calculations. The default value is checked for all motor types except fluid couplings. When using a fluid coupling the motor inertia should not be included as the motor (and the input side of the fluid coupling) come to full speed before the output shaft begins accelerating the conveyor. This motor inertia checkbox is therefore automatically unchecked if the user selects a TV, TVV, TVVS, or VSFC motor type.
Multiple Conveyor Summary
We have added the cross sectional material loading profile to the multiple conveyor design summary page.

<table>
<thead>
<tr>
<th>Cross Sectional Loading</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculation method</td>
</tr>
<tr>
<td>CEMA</td>
</tr>
<tr>
<td>CEMA</td>
</tr>
<tr>
<td>Ambient Temperature Range</td>
</tr>
<tr>
<td>16°C</td>
</tr>
<tr>
<td>10°C to 35°C</td>
</tr>
<tr>
<td>Running/Momentary</td>
</tr>
<tr>
<td>Maximum tension (kN)</td>
</tr>
<tr>
<td>98.9/134</td>
</tr>
<tr>
<td>119/130</td>
</tr>
<tr>
<td>Minimum safety factor</td>
</tr>
<tr>
<td>14.10/5.55</td>
</tr>
<tr>
<td>8.10/7.40</td>
</tr>
<tr>
<td>Minimum tension (kN)</td>
</tr>
<tr>
<td>19.8/11.2</td>
</tr>
<tr>
<td>31.9/27.2</td>
</tr>
<tr>
<td>Maximum belt sag (%)</td>
</tr>
<tr>
<td>1.03/1.79</td>
</tr>
<tr>
<td>0.77/0.67</td>
</tr>
<tr>
<td>Power Breakdown</td>
</tr>
<tr>
<td>Total installed power (kW)</td>
</tr>
<tr>
<td>224</td>
</tr>
<tr>
<td>400</td>
</tr>
<tr>
<td>Empty/Full demand power (kW)</td>
</tr>
<tr>
<td>57/195</td>
</tr>
<tr>
<td>132/287</td>
</tr>
<tr>
<td>Empty/Full demand power (%)</td>
</tr>
<tr>
<td>26% / 87%</td>
</tr>
<tr>
<td>33% / 72%</td>
</tr>
<tr>
<td>Min/Max demand power (kW)</td>
</tr>
<tr>
<td>57/195</td>
</tr>
<tr>
<td>80/323</td>
</tr>
<tr>
<td>Min/Max demand power (%)</td>
</tr>
<tr>
<td>26% / 87%</td>
</tr>
<tr>
<td>20% / 81%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Conveyor Profile Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length (m)</td>
</tr>
<tr>
<td>609.6</td>
</tr>
<tr>
<td>1236.2</td>
</tr>
<tr>
<td>731.5</td>
</tr>
<tr>
<td>1236.2</td>
</tr>
<tr>
<td>Height (m)</td>
</tr>
<tr>
<td>22.9</td>
</tr>
<tr>
<td>17.6</td>
</tr>
<tr>
<td>0.0</td>
</tr>
<tr>
<td>17.6</td>
</tr>
<tr>
<td>Minimum Elevation (m)</td>
</tr>
<tr>
<td>-0.8</td>
</tr>
<tr>
<td>-1.2</td>
</tr>
<tr>
<td>4.8</td>
</tr>
<tr>
<td>-1.2</td>
</tr>
<tr>
<td>Maximum Elevation (m)</td>
</tr>
<tr>
<td>22.9</td>
</tr>
<tr>
<td>17.6</td>
</tr>
<tr>
<td>0.0</td>
</tr>
<tr>
<td>17.6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Material Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Phosphate, Rock</td>
</tr>
<tr>
<td>Coal, Bituminous</td>
</tr>
<tr>
<td>Iron Ore</td>
</tr>
<tr>
<td>Coal, Bituminous</td>
</tr>
<tr>
<td>Tonnage (t/h)</td>
</tr>
<tr>
<td>1451</td>
</tr>
<tr>
<td>1800</td>
</tr>
<tr>
<td>3084</td>
</tr>
<tr>
<td>1800</td>
</tr>
<tr>
<td>Maximum Tonnage (t/h)</td>
</tr>
<tr>
<td>1451</td>
</tr>
<tr>
<td>1800</td>
</tr>
<tr>
<td>3084</td>
</tr>
<tr>
<td>1800</td>
</tr>
<tr>
<td>FM Case Material</td>
</tr>
<tr>
<td>Density (kg/m³)</td>
</tr>
<tr>
<td>1281</td>
</tr>
<tr>
<td>800</td>
</tr>
<tr>
<td>2403</td>
</tr>
<tr>
<td>800</td>
</tr>
<tr>
<td>Maximum Lump Size (mm)</td>
</tr>
<tr>
<td>301</td>
</tr>
<tr>
<td>150</td>
</tr>
<tr>
<td>254</td>
</tr>
<tr>
<td>150</td>
</tr>
<tr>
<td>Surchage Angle (deg)</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>25</td>
</tr>
<tr>
<td>25</td>
</tr>
<tr>
<td>25</td>
</tr>
</tbody>
</table>
Idler L10 Life Details

Even more information has been added to the Idler L10 life detailed calculations. The user can drill down to any element and see the exact values and calculations used to determine the L10 life calculations. Both vertical and horizontal bearing forces are shown, as well as the equivalent axial and radial loads. The SKF Xo & Yo (radial & axial) factors are given along with the total equivalent bearing load.

For shaft deflection calculations the roller load (without L10 load factors) is also output.
User Preferences Input Page
There have been a number of new items added to the user preferences page to allow users to customize the software to more closely reflect a given design specification or their preferred engineering design criteria. These include:

1. Allowable Idler Speed and Deflection
2. Pulley Friction Factors (Rubber and Ceramic Lagging)
3. Default Idler Installation Tolerance (vertical force for L10 Life calculations)
4. Miscellaneous Reduction Factor (overall load multiplier for Idler L10 Life calculations)
5. Allowable Bearing Turndown Ratio
6. Default Allowable Belt Sag (running & dynamic)
7. Default Designer Name for report printing

Ability to change the Shaft Tension Design Criteria Percentage
The user can now specify the specific percentage to be used for the shaft calculations in the preferences menu. Previously this was set to a fixed value of 10%. For example the user could select the running belt tensions plus 10%. Now the user can select running tensions plus any percentage they desire (i.e. 50%, or 23%, etc).
3D Terrain Modeling Improvements
Several improvements have been made to the 3D terrain modeling input and usage. Both square and rectangular surface meshes can be imported. Both computational and graphical improvements have been made to significantly improve performance.

Along with the improved 3D terrain modeling the user can also estimate the cut/fill requirements of the conveyor using the “Advanced” -> “Earthworks” file menu. We are looking forward to hearing from users to know if this is a feature worth expanding on in the future.
**Insert/Remove Rows from the Easy Profile Window**

Rows can be added and removed from the easy profile window by simply right clicking on the desired row.

---

**Ground level added to Stockpile Calculations**

A ground line level (positive elevation) can be added in the stockpile calculations to remove the effective live volume.